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Introduction

Dreamweaver is a powerful web development tool.  But new users

often find getting started with Dreamweaver to be a daunting task.

The purpose of this guide is to get you up and running with

Dreamweaver MX quickly.  In fact, you will likely have a web site

up on the Internet by the end of your second session. Once you be-

come acquainted with Dreamweaver, you’ll find it is also a very easy

tool to use.

With this guide you will learn how to construct your own personal

web site.  While any reason would do, this guide uses the project of

constructing an electronic portfolio reflecting your personal and pro-

fessional experiences.  Like any portfolio you will be able to show

evidence of your professional experiences, skills, and interests.  Be-

cause the portfolio will be web-based, anyone in the world who has

access to the Internet and a web browser (such as Netscape or Internet

Explorer) can visit it, including family and friends, colleagues, teach-

ers, and prospective employers.

This guide is presented in five sessions:

1) Creating a “root folder” for your web site on your computer

and defining a local web site in Dreamweaver;

2) How to construct a new HTML document from scratch;

3) How to link your HTML document to other web pages; and

4) Improving the graphic design and navigation of your web

site using tables.

5) How to add graphics and backgrounds to your HTML docu-

ments.

Each session is designed to be completed in one sitting (no more

than one hour), though the actual completion time will vary from

person to person.

An appendix is also included that shows how to use Dreamweaver’s

site management tools to upload your web site to a remote web server

using file transfer protocol (FTP).

This guide was written to go along with Dreamweaver version MX

2004.  Please be aware that there are many important differences

between this and earlier versions of Dreamweaver.

I designed this guide
for educators, hence
I use educational
examples
throughout.
However, the guide’s
basic structure to a
portfolio is relevant
to any professional
or student.
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How to use this guide

In each section, you will be asked to perform a series of steps to

complete the project.  Each step to be performed will be preceded

by a check box, such as this:

Select “Preferences” from the “Edit” menu.

Follow the instructions carefully and check off the step when it is

completed.  This will help you from getting confused and disoriented.

In the event that you make a mistake, these check boxes will help

you to retrace your steps.  Explanations and illustrations will

accompany these steps.  The illustrations represent what you should

actually be seeing on your screen.  You should strive to ensure that

critical elements of illustrations match exactly what you see on your

screen.

However, you will encounter lots of situations in which general

features of illustrations will never exactly match what you see on

the screen, such as the relative positions of windows.  The graphical

user interface (GUI) of Dreamweaver results in all kinds of variations

that have no bearing on the final result.  Rest assured that I’ll try to

alert you to those times when absolute accuracy is required.

Of course, it is possible that you will follow and check off each and

every step and still feel hopelessly lost at some point.  When the

inevitable happens, try not to panic.  Instead, carefully retrace your

steps starting at the last point where things seemed to be working.

Try to approach these situations with the attitude of a creative

problem-solver confronted with a challenge.

What you are expected to already know

This guide assumes you already understand basic computing con-

cepts, such as how to create and save files with applications such as

Microsoft Word.  It also assumes you have been successfully brows-

ing the World Wide Web with applications such as Netscape or Internet

Explorer.

This guide will not teach you everything there is to know about

Dreamweaver — it’s not designed to.  Therefore, after completing

this guide, it is strongly recommended that you find and use other

resources to thoroughly learn Dreamweaver and its many features.

A good place to start is the reference manual that accompanies

Dreamweaver.  Fortunately, the popularity of Dreamweaver has gen-

erated many excellent third party books as well.
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Copyright Information

This book is copyrighted and is being distributed using the

“shareware” method — you can copy this book without consulting

me, but if you use any or all of this book in your learning or teaching,

you are legally obligated to send me the royalty fee.  If you choose

not to use this guide, either destroy the copies you have made imme-

diately, or give them to another person to try.  If you were given this

guide by a friend or teacher, you too are obligated to pay for it if you

use it regardless if they sent in their payment.  (Of course, feel free to

log on to my web site and get yourself a fresh copy!)

The royalty fee as of the date at the bottom of this page is $10 (US)

for educators and students who use this guide as part of a class at a

not-for-profit school and $20 (US) for everyone else. Send your pay-

ment to the following address:

Lloyd Rieber

6114 Nowhere Road

Hull, Georgia 30646

USA

Checks or money orders should be made payable to “Lloyd Rieber.”

All payments need to be made in US funds.  I will acknowledge your

payment upon receipt.

This royalty fee is subject to change every six months.  If you obtain

a copy of this guide after six months from the date below, please

consult the following web site for the most current royalty fee amount:

http://www.nowhereroad.com/dreamweaver

I will also update this guide as needed to correct mistakes and make

other improvements, so be sure to get the most recent version.

Remember, if you use any part of this guide and do not send payment

promptly, you and/or your institution are in violation of copyright.

Please support me in trying to get quality materials into the hands of

people quickly, without hassles, and at a reasonable cost.  And be-

sides, guilt is a terrible thing!

Version: March 11, 2005
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Session 1:

Getting Your Computer Ready for

Web Development

Although I’m sure you are anxious to begin designing your first web

page, you’ll actually save time in the long run by doing a little bit of

prep work right away.  First, we need to create a new folder on our

computer that will contain all of our web work, called the “root folder”

for our web site.  Second, we will launch Dreamweaver and immedi-

ately define our web site using this root folder.

Preliminary

This guide is being written for people who most likely will be work-

ing on one and only one computer for all of their web development.

For that reason, it’s recommended that you store all original files

associated with your web site on your computer’s hard drive.  On

Windows computers, the most typical place is in the “My Documents”

folder and on Macintosh computers the “Documents” folder is a good

choice.  However, it’s always recommended that computer users get

in the habit of backing up all important computer files periodically

and systematically to some place other than their computer hard drive

as protection against drive failures.  A good place to make such fre-

quent back-ups is to removable media, such as zip disks or the now

popular USB mini-drives.  (Floppy disks are not recommended be-

cause of their limited storage space — you will find yourself quickly

filling up a single disk and it is very confusing to try to back up to

multiple disks.)  Saving copies of one’s web work to removable me-

dia will be a particularly convenient way for people who need to use

more than one computer for their web development work, such work-

ing between home and school.

We will start by creating a folder that will contain all of our web

work, not just the portfolio web site built by going through this guide.

As explained more fully in Appendix A, this folder will eventually

correspond to a folder on the web server on which our site will reside

after we upload (i.e. transfer) the files.  Dreamweaver will use the

terms “local” and “remote” to refer to the files either on our com-

puter (i.e. local) or the files uploaded to a web server (i.e. remote).

Beware! Go slow
and check off all the
boxes as you
complete the steps.
You’ll save time by
taking your time and
making sure you
understand each
step.

Your choices of
removable media may
be limited to the
computer you are
using. Many no longer
come with either floppy
or zip drives. Again,
note that floppy disks
are not recommended
due to their limited
storage size.
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Make a new directory on your computer’s hard
drive and name it “My local web files”:

Next we create a folder exclusively for our portfolio web site.  As

you will see, this folder will contain every file and graphic pertain-

ing to our portfolio.

Make a new directory on this disk and name it
“portfolio”; type in all lower case letters:

It’s a good idea to give some thought to the overall design of our web

site, such as its main parts or functions.  Although we will not deal

with how to insert graphics or images into our web pages until Ses-

sion 4, it’s a good idea now to plan for their eventual need. A good

strategy is to create separate directories for any resources we may be

using.

The portfolio directory
is your “root directory”
for your entire web site.
This means simply that
everything related to
your web site must be
contained within this
directory. The
importance of this
concept will be
emphasized throughout
this guide.

The screen shots in
this guide were
taken from the
Windows XP version
of Dreamweaver
MX. Fortunately, the
differences between
the Macintosh and
Windows versions
are slight, so
Macintosh users
should have no
problem using this
guide. When
differences are
important (such as
control-clicking
instead of right-
clicking), they will be
pointed out.

The recommended
location for Windows
users is the “My
Documents” folder.

The recommended
location for Macintosh
users is the
“Documents” folder.
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Open the portfolio directory and make another
directory inside it called “images”:

Great! We have created the essential first elements of our web site!

Time to launch Dreamweaver MX 2004.

Launching the Dreamweaver MX 2004

Application

Launch the Dreamweaver MX 2004 application.

Windows users: Click on the Start button and launch the applica-

tion:
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Macintosh Users: Find and double-click on the Dreamweaver MX

application icon:

If this is the very first time you’ve launched Dreamweaver after in-

stalling it, you will see the following window:

The “Coder” view is most useful to professional designers. The rest

of this guide uses the “Designer” interface, so that’s what we want.

Be sure that “Designer” workspace is checked,
then click OK.

You will not be bothered by this window from here on, although you

can manually access it in the Dreamweaver preferences.
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Dreamweaver opens with a special screen in the Document window

that conveniently lets you open recent files, create new files or sites,

or create from samples:

There are several windows and panels that open automatically. The

most important for us are those labeled above: Document Window,

Property Inspector, Insert Bar, and the Files panel. When no docu-

ment is currently open, you will see the menu page displayed above.

There are many, many more windows and panels that can be opened

as well! We’ll explain and use these windows as we go.

Setting up a web site

I know you are just itching to get started building a web page with

Dreamweaver, but let’s do one more thing first.  One of the most

powerful features of Dreamweaver is its site management tools.  Not

only does this greatly simplify and shorten the time it takes to main-

tain a complicated web site later, but setting up a site now will give

us access to many unique tools and opportunities even while we are

building our first pages.

There are two main parts to the process of defining a web site within

Dreamweaver:  Setting up a local site and setting up a remote site.

Before you can set up the remote site, you have to have access to a

web server, either provided to you via your school or company, or

one you pay for.  We will not worry about setting up the remote now,

but we will spend a few minutes now setting up the local site.

Insert Bar

Property Inspector

Files panel

Panel groups

Document Window

Notice the links to take
a quick tour or tutorial
of Dreamweaver —
these are good learning
resources!
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Notice the phrase “Dreamweaver Site...” in the middle column titled

“Create new”. To create a new site, click on that phrase:

Click once on “Dreamweaver Site...” in the
middle column titled “Create New”.

This triggers the site definition wizard — a step-by-step guide to

defining a site.  The first page simply asks you to give your site a

name.

Give your site the name “My Portfolio Web Site”,
then click “Next >”: You can choose any

name you want for this
— this site name is only
used internally by
Dreamweaver to keep
track of all of the sites
you set up.  This name
will never appear
anywhere later on the
Internet.
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The next page asks if you want to use a server technology. A server

technology allows you to connect your web site to an online data-

base for applications such as a guest book, shopping cart, etc. We

will not be using a server technology in this guide.

Choose “No, I do not want to use a server
technology”, then click “Next >”:

The next page asks two things:  How you want to work with your

files during development and where the files are located. We will

choose to work locally on our personal computer, then upload to a

server when ready:

The second part ask us to tell Dreamweaver where, exactly, our files

are located on our computer. We need to point to the directory we set

up at the beginning of this session.
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Be sure that the first choice (“Edit local copies
on my machine...”) is checked, then click on the
small file folder icon:

Navigate your way to the directory “My local web
files” and be sure it appears at the top of the
window:

Click “Select”.

Click here

Be sure the first
choice is selected.
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Be sure the path to this directory appears in the window:

Great! We’re almost done. Just one more step.

Click “Next >” to go to the network connection
page of the site definition wizard.

The network connection page assumes you have a live connection to

a web server. However, at this point we are going to assume that you

do not yet have access to a web server, so we will tell this to

Dreamweaver. If you do have access to a web server and want to

finish, you can go to the Appendix for the “rest of the story”.

Recall that I created
my root folder in the
“My Documents”
folder on my C: drive
(hard drive). If you
created your root
folder on a zip drive
or some other
external storage
media (e.g. USB
mini-drive), it will
have a different
letter.
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Click on the small black triangle to the right of
“Local/Network” to activate the pop-up menu and
choose “None”:

Your screen will look like this when finished:

Click on the “Next >” button.

Review this summary page. If you feel you made a mistake along

the way, you can click the “< Back” button to retrace your steps.

If all looks well, click on the “Done” button.
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Notice that the files panel now reflects your site. It mirrors how the

disk is organized with your site’s root folder:

Great! We are all set to build our first web page!
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Session 2:

Constructing a new HTML

Document

Dreamweaver provides an easy way to construct web pages without

having to learn Hypertext Markup Language programming, more

commonly known as HTML.  Instead, we can use Dreamweaver like

a word processor.  There are some key differences between

Dreamweaver and word processors, however.  One of the biggest

differences you will notice later is how graphics are handled.  You

can also use Dreamweaver to easily link one web page to another.  In

this session, you will learn how to construct a single web page from

scratch.

The first step is to open a new HTML document window.

Click on “HTML” in the “Create New” (second
column) section of Dreamweaver’s main screen:

Just so you know, there are other ways to open a new document. One

obvious way is to choose “New...” from the “File” menubar. But

there is yet another, somewhat hidden “File” choice available in the

Files panel.  To access this, you click on the tiny menubar symbol in

the top-righthand corner of the Files panel.  This opens a  “mini-file

menubar” from which you can choose “File - New File”. I like this

last choice because if you first choose a directory in the Files panel

before accessing this mini-file menu, Dreamweaver will create the

new file in that directory.  You’ll find this to be a great convenience.

(You can also access this mini-file menubar” by right-clicking in the

Files panel.)

Click here

Dreamweaver allows
you to view and modify
the raw HTML code that
it automatically
generates as you use
its “point and click”
interface.  If interested,
you might find this a
good way to learn
HTML.  However, many
people build quite
sophisticated web sites
with Dreamweaver
without ever having to
deal directly with
HTML.

Click here to access the
“mini-file menubar”
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Entering and formatting text

Let’s begin building a personal home page by typing a short bio-

graphical statement about yourself.

Type your name, followed by a brief statement
about yourself, patterned after the following:

Also notice the four phrases I typed at the end.  Later, these topics

will act as a menu where each topic links to a separate web page.  We

will learn how to construct links to other web pages in the next ses-

sion.  The use of organizing text, such as this simple menu, is a good

first step to designing your web site.

It’s also a good idea to type a “title” for your home page. This title

will appear at the top of the browser window when people access

your page.

Type something like “Lloyd Rieber’s Home Page”
in the window beside “Title:”

When someone
accesses your web site
on the Internet, this title
will appear at the top of
their browser window. If
they bookmark your
site, this title will be the
name of their
bookmark.

Obviously, you
should type your
name and
information about
yourself here
instead!

Notice that when you
press the RETURN or
ENTER key, there is
automatic double-
spacing between
paragraphs.  This is
standard.  (You can
press Shift-Enter to
start typing on the very
next line.)
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Saving your page to your root folder

Like working with any file, it’s important to save early and often.

Saving here is as easy as with any other application. However, it’s

very important that the name of the file be given special consider-

ation. Some web servers are case sensitive, so we need to pay atten-

tion to our use of lower and uppercase letters (we’ll stick to all lower

case). We also need to avoid using special characters and spaces.

Finally, all web files must end in one of several special extensions.

For example, we are going to name our first file a very special name

called “index.htm”. We’ll explain in a moment why the name  “in-

dex” is being chosen.

Select “Save as...” under the “File” menu.

Save your file to the “portfolio” directory  on your
disk with the name “index.htm”, such as the
following:

Click “Save.”

Home pages for web sites are typically named “index.htm” because

this is a very special file name for most web servers. When you enter

a web site without pointing to a specific file, the web server looks for

a file named “index.html” in that directory. If found, it displays it.

This is a nice way to keep web addresses a little simpler to remem-

ber. For example, the address for my personal web site’s home page

is “http://www.nowhereroad.com/index.html”. However, you can just

type “http://www.nowhereroad.com” and it still works.  There are

other special names as well, such as “default.htm” or “home.htm”,

but “index.htm” is the standard on most servers.

Actually, the extension
“.htm” or “.html” can be
used.  Windows users
traditionally use the 3
letter extension and
Macintosh users
traditionally use the 4
letter extension. We’ll
refer to both as HTML
files throughout this
guide.
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Notice that your page appears in the files panel window:

You’ll use this files panel window to open and manage all of your

Dreamweaver files.

Let’s turn our attention back to the content on our page.

Continue to type additional text as you would in
a word processor. Be sure to save often as you
go.

You might add some additional topics to your menu, such as “My

Educational Philosophy,” or “Instructional Materials I Have Devel-

oped”. You know, topics that might be found in a professional port-

folio.

Formatting text

The procedures for formatting your text are similar to those of any

word processor.  However, the choices are limited to only the format

options supported by HTML.  You will also need to get familiar with

the HTML terms for formatting.  For example, the format for stan-

dard text is called “Paragraph.”  Let’s change the format for the first

line containing our name.  Let’s put our name in large letters cen-

tered on the screen.

Similar to a word processor, the first step is to highlight the text you

wish to format.

Highlight your name by clicking, holding, and
dragging the mouse over the letters in your
name.

Next, we need to change this text from “Paragraph” to “Heading”

with the largest text available.

Click on this symbol
to expand (+) or
collapse (-) the
directory.

You’ll find the choices
quite limited as
compared to a word
processor.
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Select “Heading1” from the “Format” menu in
the Property Inspector:

Next, click on the “center” symbol (be sure the
text is still highlighted).

When done, your name should be correctly formatted:

You will get more accustomed to the peculiar formatting options as

you work more with Dreamweaver.

Click on this symbol to
center your highlighted
text.

Property Inspector

You can also add
color to your text by
clicking here.

You can change fonts
here. However, be
careful because if the
end user does not
have a particular font
installed on their
computer, the default
system font will be
substituted.
(Remember, too, that
users often choose to
override a page’s
fonts with their own
choices.)
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Adding a horizontal rule

A good way to separate sections of a web page is with a simple graphic

called a horizontal rule.  Let’s insert two horizontal rules — one after

your name, and one  right before the menu choices.

The horizonal rule tool can be found in the “HTML” category of

tools. However, more than likely, you are currently viewing the “Com-

mon” category of tools:

Click on the tool category pop-up menu and
choose the category “HTML”:

Click once just before the first letter of the
paragraph containing the short biographical
sketch:

Click once on the horizontal rule button.

Edit your page as you would in a word processor,
formatting it as you wish.

Horizontal rule
button

Click here...
then chose
“HTML”:

Be sure your cursor
is flashing here
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For example, I edited my home page to the following:

Save your file periodically as you work!

The next two sessions will show you how to build links from one

page to another and how to insert graphics into your web pages.

Previewing Your Web Page

Although Dreamweaver does a nice job of showing you what your

page will look like when it is actually “up and running” on the Internet,

it’s helpful to occasionally preview your page in a web browser of

your choice. The shortcut for doing this is pressing the F12 key, but

you have to have at least one specific web browser identified (up to

20 different web browsers can be chosen). It’s likely that your copy

of Dreamweaver has already chosen Internet Explorer as the default

browser. Of course, this implies that you already have Internet Ex-

plorer installed properly on your computer in a place that

Dreamweaver expects it. In a minute, we’ll explore how to set up or

change your preview browser list, but there is no harm in just trying

it out to see if it works.

Notice I added another
line of text that will be
used to link to a very
useful educational web
site offered by the U.S.
Department of
Education.

Two horizontal rules
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Select “File - Preview in Browser - iexplore” from
the menubar, or press F12.

If it works, Internet Explore will automatically be launched and your

Dreamweaver page will appear in a new window:

Notice that this is an
internet Explorer
window — you are no
longer in Dreamweaver.
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If it didn’t work, you may have received any number of messages,

the most likely being that Dreamweaver couldn’t find Internet Ex-

plorer and whether you would like to edit the preview list.

If Internet Explorer was launched and opened your page in a new

window for you, close this window and go back to Dreamweaver.

Close all windows except the one containing
your web page in Dreamweaver.

Let’s go through the steps of selecting a web browser. Even if things

worked fine for you when you pressed F12, you may want to use

Netscape Explorer, or at least add it as a secondary browser.

Select “File - Preview in Browser - Edit Browser
List...” from the menubar:

This brings up the Preview in Browser Preference dialog box.

Next, we’ll quickly go through some of the steps to find, add or

delete a browser.

If Internet Explorer did not launch when you
pressed F12 earlier, but you know you have it
installed on your computer, click on the “Edit”
button.

The following dialog box appears:

The text beside
“Application” may be
missing or different.
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Click on the “Browse...” button, then navigate
your way to the Internet Explorer application and
choose to open it; Click “OK” when done.

Let’s add Netscape Communicator (or Navigator) to our list while

we are here. Again, this assumes that you already have Netscape

Navigator installed on your computer.

In the “Preview in Browser” Preference window,
click on the small plus (+) sign beside
“Browsers”.

Click the “Browse” button and navigate your way
to the Netscape Communicator application and
choose to open it.

Click in the check box to make this your
secondary browser.

Your window should look like the following:

Click “OK”.

Your “Preview in Browser” Preference Window should look like this:

Windows Alert!
A good place to start
your search is in a
directory called
“Program Files” on the
C: drive.

Macintosh Alert!
If you don’t find Internet
Explorer as soon as
you enter your hard
drive, then first look for
an “Internet
Applications” folder,
followed by an
“Applications” folder.

Click here to add a
browser to the list.

Click this button to
browse your computer
for the Netscape
application.
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Click “OK” to accept all the changes and to leave
the “Preview in Browser” Preference Window.

Press F12 as often as you like from here on to
preview your web page in your chosen primary
browser.

Save often.

Follow-up Activity

Practice the skills learned in this session by creating another new

Dreamweaver file to contain your professional resumé.  If you al-

ready have a resumé typed into a word processor, you can “copy and

paste” it from the word processor into Dreamweaver.  Be sure to

again save this Dreamweaver file to your portfolio folder with a title

of your choice (e.g. “resume.htm”).

Here’s an example:

Notice the sentence I included at the bottom — “Click here to go to

Lloyd Rieber’s Home page” — indicating, obviously,  a link back to

my home page:

In the next session, you’ll see how to link the two files together.

We’ll briefly show next how to create a new web page.

Remember to
include a title for
your page, such as
“Lloyd Rieber’s
Resume”.

However, remember
the earlier warning
about the difference in
formatting between
HTML and word
processors.  Even if
you copy and paste
your resume from a
word processor to
Dreamweaver, expect
to spend considerable
time reformatting the
Dreamweaver file.
Fortunately, most word
processors, such as
Microsoft Word, provide
the option to “Save as
HTML...” The files you
save this way can then
be opened and refined
with Dreamweaver.
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Recall from page 17 that there are several ways to create a new file.

Again, the most obvious is to choose “New...” from the “File” menu.

However, let’s take advantage of the “mini-file menubar”. This short-

cut will quickly create a new file exactly where we want it in our site.

In the Files panel, click on the “Portfolio” folder,
then click on the small file menubar symbol in
the top-righthand corner:

Choose “File”, then “New File” from this pop-up
menu.

This creates a new “untitled” document inside the Portfolio direc-

tory:

Click here

By first choosing the
“Portfolio” folder, this
tells Dreamweaver the
destination for the new
file.
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Rename this “resume.htm”:

Pretty nice shortcut!

Now, let’s open this newly created file by double-clicking on it.

Double-click on the file “resume.htm” to open it.

This new page opens, overlapping any other pages already open:

Obviously, it will be difficult to manage even a small number of

pages open at the same time.  Fortunately, the Windows version of

Dreamweaver MX 2004 has a useful feature built into it to help orga-

nize these pages.

Choose to maximize any of the pages now open.

Click on the “maximize”
symbol of any page
currently open.

Macintosh Alert!
Unfortunately, this step
will not work.  The
Macintosh version only
allows for floating
windows.



30 Introduction to Dreamweaver MX Session 2:  Constructing a new web page

Notice how the pages align themselves automatically.  Each open

page has its own tab you can click to access it:

Here is my resume page, freshly typed:

Again, in the next session you’ll learn how to link these two files

together.  Don’t forget to save often as you!

Choose to save often as you create your resume
web page.

Click on one of these
tabs to access a
particular page.

Don’t get bogged down
at this point trying to
create the perfect
resume page with all
the possible information
about you. You will
have plenty of time later
to work on it. However,
be sure to create this
new page with at least
some token information
now — we will be using
this page to
demonstrate how to link
two pages together in
the next section.
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Taking a Look at your Root Folder

It’s useful to take a look inside your root folder at this point. Recall

that we made a directory named “My local web files” at the start of

session 1 to store all of our web sites.  Then we created the directory

“portfolio” as the root folder for our portfolio web site. Now that you

have created at least two HTML files, your root folder should re-

semble the following:

As we finish this session, consider how your entire web site is now

contained within the directory named “portfolio”.  All the files you

add or create, such as HTML files, graphics (which we will cover in

session 4), sounds, etc., will be contained inside your “portfolio”

directory.

It’s also a good idea to make a back-up of your root folder onto a

separate disk.

Make a back-up of your “portfolio” directory onto
another disk.

Uploading your files to a web server

Before others can access your web pages, you must upload (i.e. trans-

fer or copy) all of your files to a web server.  Fortunately,

Dreamweaver has excellent site management tools that make “talk-

ing”  to a web server easy (i.e. uploading and downloading files).

These site management tools are covered in the Appendix. There are

also separate FTP applications that you can also use to do this. FTP

stands for “file transfer protocol”. WS_FTP is the most common Win-

dows FTP application and Fetch is the most common Macintosh FTP

application.  Here is a good resource for learning how to use these

FTP applications:

http://www.arches.uga.edu/upload.html

However, there is no need to rush.  You can upload your files at any

time and as often as you wish. But if  you are anxious to get “on the

web,” either go through the Appendix now or learn how to use an

FTP application.

Windows Alert!
You might find it helpful
to see the extensions of
all files while working
through the rest of this
guide. To do this, you
will need to turn off the
option to “Hide
extensions for known
file types.” This option
is found in the control
panels:  Go to the
section “Appearance &
themes”, then choose
“Folder Options” and
click on the “view” tab.

Notice that my
HTML files are
associated with
Internet Explorer.
Your HTML files may
be associated with
Netscape instead,
meaning that
Netscape is the
default application
for your “.htm” or
“.html” files. If you
double-click on a
file, your default
application will
launch and then
open the file. To
open these in
Dreamweaver, or
another appropriate
application, you
would have to
launch the
application first, then
open the file from
the application. It’s important to put

back-ups on drives or
disks other than the
one on which your web
site is currently stored.
You want to make you
can recover important
files if your hard drive
or disk crashes.
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Session 3:

Linking to Other Web Pages

As already mentioned, HTML stands for Hypertext Markup Lan-

guage.  The prefix hyper- translates best as “linking.”  In fact, one of

the most powerful features of the World Wide Web (i.e. the Internet)

is the ability to link any web page with another.  All you need is the

web address (called a “Uniform Resource Locator,” or URL) of the

web page to which you wish to link.  Instead of learning all of the

HTML commands and programming the web page ourselves (with a

text editor), this session again shows you how to use Dreamweaver

to construct these links.

Preliminary

Let’s start this session by briefly getting reacquainted with where we

ended the previous session. Recall that we created two HTML docu-

ments and saved them inside the “portfolio” directory, which is like-

wise located inside the “My local web files” directory.  The “portfo-

lio” directory is the root folder for your portfolio web site and the

“My local web files” directory is where you will be saving all of

your web sites. You either created these directories on your computer’s

hard drive or on some removable media, such as a floppy or zip disk.

Find and open the directory titled “portfolio”:

Obviously, we need to launch Dreamweaver to continue working on

our web site. However, if you are working in a Windows computer,

notice that your “index” and “resume” files are considered as “be-

longing” to Internet Explorer on my computer (as signified per the

blue “e”). Therefore, if I double-click on the file, Windows will launch

Internet Explorer instead of Dreamweaver. Your files may be associ-

Obviously, if your
portfolio web site is
located on a floppy or
zip disk, you need to
insert that disk first.

“http://www.ford.com” is
an example of a URL.
Later you will form your
personal URL, which
will become your
address on the World
Wide Web.
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ated with Netscape instead, meaning that Netscape is the default ap-

plication for your “.htm” files. If you double-click on a file, your

default application will launch and then open the file. We don’t want

that. To open these in Dreamweaver we have to first launch the

Dreamweaver application first, then open the file from Dreamweaver.

On a Macintosh computer, in contrast, the files are identified as

Dreamweaver files and double-clicking on either will launch

Dreamweaver:

However, for consistency between platforms (and to avoid any con-

fusion), let’s get in the habit of launching Dreamweaver first, and

then opening a file from within Dreamweaver’s files panel.

Launch the Dreamweaver application.

Your screen should resemble the following:

Files panel
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If you are using the same computer as that in the first two sessions

and the last person to use Dreamweaver, your portfolio web site will

open automatically in the files panel:

If you just started working on a different computer, either another

Dreamweaver site has opened in the files panel (probably belonging

to another person), or you will see Dreamweaver’s general opening

screen indicating that no site has yet been defined. If either of these

situations apply, you’ll need to first define a site just like you did in

Session 1 in the section “Setting up a web site” on page 10.

Once you have finished getting your site defined just like it was at

the end of the previous session, proceed to the next step.

It may not be obvious how to create a new site if a site other than

yours is open. All you need to do is click on the mini-menubar sym-

bol in the top-righthand corner of the Files panel, then choose “Site”,

then choose “New Site...”:

The next step assumes your site appears in the Files panel.

From the Dreamweaver files panel, open the file
“index.htm” by double-clicking on it.
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Your screen should now resemble the following:

Linking Your Personal Web Page to Another

Web Page Already on the Internet

Let’s build our first link to the “Federal Resources for Educational

Excellence Home Page” at the bottom of the page.  We are going to

make these words active, or “hot,” meaning that when a user clicks

on them, they will be immediately taken to this web page.

The first step to making any word, phrase, or sentence active or “hot”

(i.e. linking to another page) is to highlight the text.

Highlight the sentence “Federal Resources for
Educational Excellence Home Page” by clicking,
holding, and dragging over the letters of the
words:

Alternatively, you could have clicked on the paragraph tag, marked

“<p>” in the bottom left hand corner. This refers to the text associ-

ated with this tag. This is a handy shortcut in Dreamweaver.

A shortcut to
selecting a block of
text is clicking on
one of the HTML
tags located here,
such as the <p>
(paragraph tag). You
will see this list of
tags change,
depending on the
tags at the text
insertion point (i.e.
where the vertical
bar is flashing).



36 Introduction to Dreamweaver MX Session 3:  Linking to other web pages

Next, type the web address (URL) in the text box at the bottom left

of the screen (beside the small globe).

Click once in the text window beside “Link” in
the Property Inspector and type the URL for this
web page:

For example, here is the URL for this government web site:

http://www.ed.gov/free/

When finished, press return.

Notice that these words have now changed color and they are under-

lined.  This indicates that the text is “hot,” meaning that it will link to

another web page when clicked.

It’s also important to tell Dreamweaver where to open this link. This

is called the target. The most typical targets are the parent window

(the new page will replace the old) or a blank window (the new page

will open in its own window). This is an important decision, as it can

be very disorienting if the user expects it one way and opposite hap-

pens. In this case, it makes sense for the new page to open in a blank

window because the link is “outside” of our web site.

Click on the little triangle beside “target” in the
Property Inspector to show the pop-up menu:

Choose “_blank”:

Type the URL here

Property Inspector

This address is an
example of an
absolute link. We will
contrast this to a
relative link in the next
section of this session.

Instead of typing
this manually (and
perhaps making an
error), you could
launch a web
browser (such as
Internet Explorer or
Netscape), go to
this web page, and
then copy and
paste this address
from the web
browser to
Dreamweaver.

Pressing return is
just one way to tell
Dreamweaver to
accept this text.
Another way would
be to press the tab
key, or simply to
click on any other
spot in the document
window.

A good rule of thumb is
that all new pages that
are part of the web site
should open in the
same (parent) window,
but links to pages that
are part of other,
separate web sites
should open in a new
(blank) window.

Click here to activate
the pop-up menu.

Be sure “_blank”
appears in the target
window.

Tags are HTML
commands that modify
a screen object (such
as text) or specify an
action (such as a link)
on the HTML page.
We’ll “peek behind the
curtain” at the HTML
code a little later.
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Previewing the Page to Test the Link

We can test this link by previewing the page in Internet Explorer.

Press F12 to preview our file in Internet Explorer.

Move the mouse over the “hot text” and notice
that the web address now appears in the text
window at the bottom of the screen:

Why stop there? Let’s see if the link really works.

Click on the hot text to go to this government
web site:

The URL of this “hot
text” appears here in
the web browser.

Refer to session 2 for
identifying one or more
web browsers for
previewing
Dreamweaver
documents.

This only works if you
have a live Internet
connection.
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None come to mind?
Try these:

Public Television
http://www.pbs.org

Smithsonian Institution
http://www.si.edu

U.S. Civil War Center
http://www.cwc.lsu.edu/
civlink.htm

World Lecture Hall
http://www.utexas.edu/
world/lecture/

NASA
http://www.nasa.gov/

Bad Science
http://www.ems.psu.edu/
~fraser/BadScience.html

ExploreLearning.com
http://
www.explorelearning.com/

This is called a
bulleted or
unordered list. To
make it, highlight the
lines, then choose
“Text - List -
Unordered List” from
the file menu.

Notice that this link opened in its own window, due to the fact that

we selected “_blank” for the target.

Have you saved recently?

Select “Save” from the “File” menu.

Find several web pages on the Internet that you
wish to link from your home page and write down
their addresses (URLs) carefully.

If any of the web addresses have even the slightest error (such as a

lower case letter “l” instead of the number “1”), the link will not

work.  A good strategy is to run Netscape or Internet Explorer while

you are using Dreamweaver so that you can just copy and paste web

addresses as you find them.  This guarantees that the web addresses

will be correct.

Construct “hot text” to link to each of these web sites.

For example, I constructed links to the following web sites:

Linking two Dreamweaver files

Dreamweaver offers an easy way to link one Dreamweaver file with

another.  You must have another Dreamweaver file already constructed

in order to complete this section (such as the web page you con-

structed to contain your professional resume as discussed in the “Fol-

low-up Activity” in session 2 on page 27).

There are several ways to do this. We’ll show two, with the first

being the most convenient.  The first step for both is to highlight the

text that will become the link to the second page.
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Highlight the text “Professional Resume” in the
index.htm file:

Next, we use the “Point to File” icon (it looks like a dart board) to tell

Dreamweaver which file we want this text to link to.

Click, hold, and drag the “Point to File” target
icon to the resume.htm file in the files panel
window:

Notice the link to “resume.htm” now appearing
in the text box beside “Link”.

It’s important to notice that the usual “http://...” does not appear. In-

stead, only the name of the file appears. That is because the link to

“resume.htm” is relative to the file “index.htm”.  The difference be-

tween relative and absolute links is one of the most fundamental prin-

ciples in web design.  Again, this speaks to the importance of a root

folder. Links from one file in the root folder to other files or resources

Click, hold, and drag
from here...

...to here.

Remember the
shortcut of clicking
on the <p> tag?

Your cursor needs to
be blinking
somewhere on the
desired text block
first.
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in the root folder are all relative to each other.  When you type “http:/

/” in front of a URL, the link goes absolutely to one and only one

location on the Internet. When the link is relative, the root folder can

be anywhere on the Internet — your browser is smart enough to fig-

ure out how to determine the rest of the URL.

Let’s take a moment to study the result:

Notice that the text again changed to blue. Most important, notice

that the relative link to “resume.htm’ appears in the Inspector Win-

dow beside “Link”. This means that when we preview the link, our

web browser will look for a file called “resume.htm” in the same

directory as it had found “index.htm”. We’ll just leave the target

empty at this point.

Let’s show a second way to create a link.   This is the standard “browse

for file” approach.

After highlighting the text for the link, you click on the small graphic

of a folder to the right of the text box beside “Link”:

After you highlight the
text for the link, click
here to point to the
page on the disk you
want to link to.

I know this is still
probably as clear as
muddy water — if so,
don’t fret. It will become
clearer as we go.
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A standard file dialog box appears.  Navigate to the “portfolio” di-

rectory:

Select “resume.htm’.

Click “OK” to accept the link.

Just so you know, there is a third way you could have created this

link after highlighted the text — you could have just typed the name

of the file you wanted this text to link to instead. However, the “Point

to File” procedure is probably the easiest way to link any

Dreamweaver file to another, thus facilitating the construction of a

complex web site. But, no approach is wrong if it works!

Let’s save the file before we test the link.

Save your file.

OK, let’s see if the link works by previewing the page in Internet

Explorer.

Press F12 to preview the page in Internet
Explorer.
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Your screen should resemble the following:

Click on the link to “Professional Resume”; the file “resume.htm”

from your disk should appear in the browser window:

Cool!

Of course, we’re a little stuck right now because there is no obvious

way to get back to our home page. Fortunately,  we have already

designed the text to get us there at the bottom of this page. All we

need to do is go back to Dreamweaver to set up another link there to

take us back. No problem!

Close the Internet Explorer window and select
the Dreamweaver window.
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Choose to open the “resume.htm” file by double-
clicking on it in the files panel:

Highlight all the text beginning with “Click here
to go to...” at the bottom of the page.

Click, hold, and drag the “Point to File” target
icon to the index.htm file in the files panel
window:

The URL link should show “index.htm’:

Again, you could just
type the name of the
file you wish this text to
link to in the text box
beside “Link” —
“index.htm” in this case.
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Let’s save the file before we test the link.

Save your file.

OK, let’s see if the link works.

Press F12 to preview this page in Internet
Explorer.

In Internet Explorer, scroll down and click on this
link to test it.

If you followed the steps properly, this link should take you back to

your home page (i.e. “index.htm”).

You can now toggle back and forth between these two pages at will

while previewing them within Internet Explorer!

Looking “Behind the Curtain” at the HTML

Code

This is a nice opportunity to take a look at the raw HTML, the actual

code that actually makes the page work.

Close all Internet Explorer windows and go back
to Dreamweaver.

Click on the tab to view the file “index.htm”.

Scroll down the page and click once somewhere
inside the text “Professional Resume”.

Notice that another HTML tag has appeared: <a>

As always, be sure to
save each file you are
working with
periodically. Remember,
selecting “Save” from
the “File” menu only
saves the file whose
window is currently
active (e.g.
“resume.html” in this
case). It is common to
have more than one file
window open at a time,
and it is easy to forget
about unsaved changes
to other file windows
currently open, but not
active.

Notice that a third
HTML tag now
appears: <a>
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The <a> tag is used to identify hyperlinks. If you click on the <a>

you will find that it too highlights the same block of text as does the

<p>. That is because both tags modify the same text.

Let’s “peek behind the curtain” to see what actual HTML code goes

along with this <a> tag. Dreamweaver makes it easy.

There are three buttons on the left hand side of the tool bar:

We have been in the “Show Design View” all along. But, let’s click

on the “Split” button to get a split screen of the HTML code and the

document window.

Click on the “Split” button to show both the code
and design views.

You can now explore your file from two vantage points at the same

time:  HTML code and the WYSIWYG document window.

If you haven’t already, click once on the <a> tag
at the bottom of the document window.

This highlights all of the HTML associated with this tag. We are not

going to try to teach HTML coding at this point. But take some satis-

faction in knowing that Dreamweaver converts each and every key

press and mouseclick into the proper HTML code for you. As you

develop your web design skills, you’ll almost assuredly have a need

to learn more about HTML code. So, also take some satisfaction in

knowing that Dreamweaver will make it easy for you to live and

work in “both worlds”.

WYSIWYG — what you
see is what you get

Show Design View

Show Code View

Show Code and
Design Views
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Again, be sure to save each file you are working with periodically.

Remember, selecting “Save” from the “File” menu only saves the

file whose window is currently active (e.g. “resume.htm” in this case).

Save each file after first making its file window
active.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Upload your files to a web server (see Appendix).

Launch a web browser (i.e. Netscape or Internet
Explorer) and review your pages from the server
to make sure they are working properly.
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Session 4:

Adding Graphics to Your Web Pages

Graphics are a very popular feature of the World Wide Web.  When

used appropriately, graphics add an important element to your web

pages.  However, graphics can take up large amounts of memory and

require much longer to download over the Internet than text. There is

nothing more annoying than having to wait several minutes for a

single web page filled with unnecessary graphics to load.  Remem-

ber also that too many graphics, especially when designed poorly,

can easily distract a person’s attention away from the important ideas

you are trying to communicate in your web pages.  Use graphics

prudently to enhance your web site.

A little background about graphics on the

web

It is important to understand how and where graphics are stored in

web pages in order to successfully complete this session.  Unlike

regular word processing files, graphics are not contained directly in-

side an HTML document, but instead are stored as separate files on

the disk.  An HTML file merely “points” to the place where a graphic

is stored on a disk.  If found, the graphic is then loaded into the

computer’s memory and the graphic appears on the screen inside

your browser’s window.  If not found, an empty block is shown in-

stead.  If the path to the graphic is somehow broken, the graphic will

not appear.

Another important fact about graphics on the web is that they have to

be saved in one of a few very special file formats.  The two most

common graphic file formats are GIF and JPEG.  Both file formats

compress the graphic so that it takes up as little space as possible

when it is transmitted over the Internet.  The GIF format is probably

the most common (and one of the oldest) and was introduced by

CompuServe as a way to help its subscribers transmit graphics.  JPEG

files allow greater resolution than GIF.  The only file format we will

work with in this session are GIF files.

Web pages load one
page at a time.
Therefore, instead of
designing one long
page with many
graphics, consider
breaking the page up
into a series of smaller
pages linked together.

The path to the graphic
file can be broken
either by later moving
the file or changing the
file’s name.

GIF stands for
“graphics interchange
format.”

JPEG stands for “joint
photographic experts
group.”
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Preliminary: Finding Already Existing GIF

and JPEG Files

Before we can add graphics to our web pages, we first have to find

some GIF or JPEG graphics. This guide does not teach how to create

your own, though it is not very difficult. Most of the graphics appli-

cations available today allow you to create and save your graphics in

the GIF and JPEG formats. Even the simple Paint program that comes

free with the Windows operating system has this feature. On the

Macintosh side, the drawing and paint features of AppleWorks have

this feature. But if you find yourself needing to do a lot of graphics

development work for the web, buying programs such as Adobe

PhotoShop or Macromedia Fireworks will be a good investment.

So, where can one find existing GIF and JPEG images? Fortunately,

there are literally hundreds of web sites that give away  web resources

such as GIF and JPEG files for free.  At the end of this session is a

listing of several of the best ones. But, just to get us started with

some consistency, I’ve put a small collection of GIF files on the

Internet for you to download and copy. It is perfectly legal for you to

copy and use these on your web site.

Download a sample of GIF files to be used in this
session from one of the following URLs.

Windows users:
http://www.nowhereroad.com/dreamweaver/gifclipart.zip

Macintosh users:
http://www.nowhereroad.com/dreamweaver/gifclipart.sit

Both “.zip” and “.sit” files are compressed and are unusable until

they are uncompressed. The two most common applications to do

this on a Windows computer are WinZip and EnZip. On a Macintosh,

Stuffit Expander is the most common. (Your computer may be set up

to do this automatically — if so, just pay attention to where the files

are being saved and uncompressed.)

Uncompress the files and put the resulting “GIF
clip art” directory on your computer’s desktop.
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Open the directory containing the GIF files in
preparation for copying them to your root folder.

The following window should be open on your desktop:

Copying These GIF Files to Your Root

Folder

The next step is a very important!  You have to copy (or move) all of

these GIF files to your root folder. If you fail to do this properly, the

graphics will not appear when you upload your site to a web server

even though they may appear when you test your pages locally.

Select all of the contents of the GIF clip files and
copy or move them into the “images” directory
inside your “portfolio” directory on your disk.

The site management
features of
Dreamweaver contains
several utilities to
prevent mistakes like
this from happening.
When you have a site
set up properly,
Dreamweaver will
“notice” if a graphic you
are about to use is
inside or outside of your
root folder. If outside, it
will ask you if you want
to copy to your root
folder. Very convenient!
(Again, instructions for
how to set up a remote
web site are contained
in the Appendix.)
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When done, your “images” directory should contain the following:

Now we are ready to use these GIFs in our web site!

Adding Already Existing GIF Files to Your

Web Pages

Dreamweaver makes it very easy to insert GIF files directly into your

pages with the Insert Image button — the tree — on the Insert Bar:

Again, it is very important that the GIF files you want to use are

already located in the root folder of our web site before using the

Insert Image button.  The reason is that Dreamweaver simply makes

a reference to the graphic file when you use this button.  If it is not

already located in the appropriate folder, you may break the link when

you copy your web site to the web server.  If you followed the last

series of steps correctly to download the small clip art collection,

followed by correctly copying them to your “images” folder, you

should be ready to add any of those GIF files to your web site.  Let’s

consider an example to clarify this.

Launch Dreamweaver.

As always, if you are working on the same computer as you did the

previous sessions and you are the last person to have worked on

Dreamweaver, your portfolio web site will come up automatically.

If this is not the case, you will again need to define a local site, as

described in session 1.

Insert Image button
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Open your home page “index.htm”.

We simply now need to choose where to insert an image on this page.

Let’s add a little flair to our home page by placing little red apples on

either side of our name.

Move the cursor to the point where you want to
insert the GIF file and click once.

The text insertion point (blinking vertical line) should be blinking

just in front of your name:

Click once on the Insert Image button in the Insert
Bar.

If you click on the small triangle just to the right of the tree graphic,

you will activate the following pop-up menu:

As you can see, there are many options for inserting graphics. All

we want to do is insert a simple graphic, so be sure to choose

“Image”. If you clicked directly on the tree graphic, you will not

see this pop-up menu.

If the pop-up menu is showing, click on “Image”.

The “Select Image Source” window opens.

The text insertion
point should be right
here

You know, kinda like
an apple for the
teacher!
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Navigate to the GIF file named “apple.gif” inside
the “images” directory:

Notice the URL of this graphic (“images/apple.gif”). This translates

into “starting at the root folder, you can find this graphic inside of the

images folder with the name apple.gif”.

Click “OK”.

Here is the result:

Notice a couple of things. First, the apple graphic has handles around

it which allow you to easily resize it. You can also easily move it to

any other location on this page just by dragging it.

If this file is not there,
then you did not copy
the GIF files to your
images directory
correctly.  Take the time
now to repeat the
preceding steps
correctly.
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The second thing to notice is the source location of this file in the

Property Inspector. It should not be surprising that this again is listed

as “images/apple.gif”:

Also notice the text field labeled “Alt”. This stands for alternative

text. If a person who is visually impaired visits your web site using a

screen reader, a device that “reads” aloud text on a web page, the

screen reader will look for alternative text when it encounters a

graphic. If no alternative text is available, the person is left wonder-

ing about the graphic. Not only is entering alternative text the proper

thing to do, it is also required by Federal law according to Section

508 of the Americans with Disabilities Act. So, get in the habit of

including alternative text for each and every graphic.  Write your

alternative text briefly, but carefully so as to describe the graphic

adequately. Obviously, this little graphic of an apple is meant solely

for decoration, so we don’t want anyone investing any substantial

mental energy into its purpose.

Enter “A small decorative apple” in the Alt field.

We want to repeat the procedure to place another apple graphic on

the right side of your name. However, let’s do it  in a different way

that is absurdly simple.

In the Files Panel, choose to expand the images
folder.

Click, hold, and drag the “apple.gif” graphic just
to the right of your name in the document
window:

Yep, it’s that easy!

A good web site to
visit to get acquainted
with how to comply
with accessibility
issues is the following:

bobby.watchfire.com

The Bobby site also
includes a free
resource allowing you
to scan a web site to
check if it is in
compliance and offers
suggestions on what
to do if it is not.

Don’t forget to include
similar alternative text
for this second apple.

This is known simply as
an “Alt Tag”.
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Although you see two apples, there is really still just one apple stored

on the disk. The computer is smart enough to make its own copy of

the graphic on the screen. This saves a lot of file space. You could

place thousands of these apple images on your page and still only

need to have one copy on the disk.

Here’s another example. I wrote the following at the bottom of my

home page.  I want to add a little “Under Construction” graphic to

indicate that the web page is not quite finished. Notice where the

cursor is blinking.  This is the place where I want to place the graphic:

Let’s insert the graphic the easy way.

Click, hold, and drag the “undrconst.gif” graphic
from the Files Panel to the appropriate place on
the page:

The graphic you selected appears in your page.  Again, since this

graphic is stored in your root folder, the graphic and the link to it will

be available when the folder containing your web site is copied to

the web server.

Select “Save” from the “File” menu.
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Adding a background to your web page

The final technique we will show is how to add a textured back-

ground to your web page.  This will help give your web page a dis-

tinctive “feel.”  Any GIF file can be used also for a background

graphic.  The graphic will be automatically duplicated and “tiled”

behind the existing text and graphics on your web page.  For ex-

ample, we will use the GIF file named “paper1.gif” — it looks like

textured paper.

To use this background graphic on our web page, we need to access

the Page Property window.

Select “Page Properties...” from the “Modify”
menu.

The Page Properties window opens:

This window has a very interesting assortment of properties you can

modify, all of which will modify the look and feel of your web page.

For example, this is the place where you can change the background

color or the default text color. However, our goal is to change the

background so that it has the textured look of paper.

Alert!
Be very careful in
choosing backgrounds.
The wrong choice can
turn your web page into
a disaster!
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Click on the “Browse...” button to the right of
“Background Image.”

This also opens the “Select Image Source” window.

Navigate to the file “paper1.gif” in the
“backgrounds” directory (located in the
“images” directory in “portfolio”):

Click “OK”.

This sends us back to the Page Properties window:

Notice the path to this image: “images/backgrounds/paper1.gif”

Click “OK”.

Like all graphics, a
background is stored as
a separate GIF (or
JPEG) file on the disk.
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The page has been transformed to appear as though the text and graph-

ics are on a piece of paper.

Save your file.

Make a back-up of your “portfolio” directory onto
the hard drive of your personal computer.

Upload your files to a web server (see Appendix).

Launch a web browser and review your pages.

Graphics Resources

There are lots of web sites where you can get free-to-copy graphics

to use in your web pages. Here are just a few:

The Clip Art Connection

http://www.clipartconnection.com/

One of the largest on-line clip art collections.

Free Backgrounds

http://www.bsugraphics.com/backgrnd.htm

Animated Clip Art

http://webclipart.miningco.com/msub2.htm

Remember, you can find your own resources by entering keywords,

such as “free gif clip art”, at any of the major search engine sites (e.g.

www.yahoo.com, www.altavista.digital.com, and www.google.com).

Any GIF or JPEG file
will work! You could
even choose a JPEG
containing your photo
— I don’t recommend
this design, but if you
want to see yourself on
the web, this is
probably the most
exaggerated way to do
it!
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Session 5:

Using Tables to Enhance Your Web

Site’s Aesthetics and Navigation

It’s time to take stock of your accomplishments up to this point. You’ve

successfully used Dreamweaver to create a web site consisting of

pages linked together. You have also learned how to add graphics to

those pages. However, before we go any further, you should think

about the overall design of your web site.  In this session, we will

explore two important and complementary aspects of web design —

aesthetics and navigation.  When designed together well, your web

site will be enhanced greatly.  However, the temptation for many

people is to focus on the look and feel of a web site without much

regard to navigation.  This is a mistake I want you to avoid.  It makes

no sense to design a visually attractive web site in which people get

lost.  Our aim is to design a web site in which the visual appeal con-

tributes to the ability of visitors to navigate your site easily.  In fact,

the best designed web sites make navigation appear effortless. In

order to accomplish both of these goals, we will introduce one of the

most useful tools available to a web designer — tables.

Tables

Tables are a popular and useful feature of current word processors

and, fortunately, tables within Dreamweaver work in a way that is

very similar. A table is nothing more than a grid consisting of one or

more rows and columns.  The places where rows and columns inter-

sect are called cells.  Tables have traditionally been used to organize

information, such as weather data, types of plants, flowers, animals,

etc. Anyone who has ever used graph paper knows the beauty of

using a grid system to organize data. However, in addition to orga-

nizing information, tables also serve as marvelous ways to organize

the layout of web pages.

The purpose of this session is to introduce you to tables in the con-

text of meaningfully organizing the space on a web page. Organizing

this space will serve two needs.  First, you will find tables to be a

wonderful way to enhance the aesthetics of your page. I’m sure you’ve

been a little frustrated up to his point with our use of graphics. A

typical request from new designers is how to put a graphic “off to the

side” of a page and away from the main text. Tables allow you to do

this. But, rather than just doing so haphazardly, we will advocate

thinking of a web page as a collection of “zones”.  For simplicity,

we’ll focus on three zones: title zone, information zone, and naviga-

tion zone.  In this session we will create a 3 X 3 table (that is, a table

with three rows and three columns) to create these zones along with

an attractive border. We will also show how to begin using color

effectively.
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If you’ve completed the previous four sessions, you should at least

have a home page (titled “index.htm”) and a resume (titled

“resume.htm”). In this session, we will create these same two pages

again from scratch. You can either delete the two pages you have

already made, or, if you don’t want to lose the time you’ve invested

in them, rename them for later use (it is very easy to “cut and paste”

information from these old pages into the new ones we will make in

this session).

Launch Dreamweaver and open the “My Portfolio
Web Site”.

This site will automatically open if it was open the last time you used

Dreamweaver.

Either rename or delete your existing
“index.htm” and “resume.htm” files.

I’ll take the conservative route and rename my existing two files. An

interesting pop-up message appears when I do so:

This is a very useful tool within Dreamweaver. Basically, it’s asking

permission to update all links affected by the retitling of this file

name.  One of the advantages of using Dreamweaver for site man-

agement is that it keeps track of all of the links within your site.  If

To delete these files,
click once on each and
press the delete key on
the keyboard.
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you make a change to anything that affects one or more links, it of-

fers to update everything accordingly. In a large site, this is an enor-

mous time saver. Even though you may ultimately decide to delete

these two files, let’s have Dreamweaver update the links so that these

two files will continue to be linked together. (Important note:

Dreamweaver can only perform this service if you choose to rename

files within the Files panel of Dreamweaver. If you rename the pages

on the desktop, the links will be broken and the only way to fix them

will be to go in and manually redo each and every link. This is some-

thing you definitely want to avoid having to do!)

Choose to update the links in the files indicated
when you rename both of these files.

Okay, let’s move on to creating a new home page for our site.

In the Files panel, click on the “portfolio” folder,
then click on the small file menu bar symbol in
the top-right hand corner and choose “File - New
File”:

Or, you might recall that you can take the short cut of right-clicking

directly on the “portfolio” folder to access this pop-up menu. The

file is automatically titled “untitled.htm”.

Rename this file as “index.htm”.

Double-click on the file “index.htm” to open it.

The first thing we need to do is insert a table.

Click here
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From the File menu, choose “Insert”, then
“Table”:

We are presented with a dialog box of properties for the table. Be-

sides indicating how many rows and columns we want we can also

initially set other properties for the table from the very start. Here’s a

brief description of a few of these settings:

Border thickness: As the name suggests, the larger the number the

thicker the border of the table. A border of 0, our preference, results

in no border, though while in development we will at least see a

dotted line.

Cell spacing:  The larger the number, the larger the space between

cells of the table. (We’ll set ours to 0.)

Cell padding: The larger the number, the more space between infor-

mation or content in the cell and the cell’s border. (We’ll set this to

20. This will give a nice margin for our content.)

You will also notice that you can choose either “pixels” or “percent”

for table width. If you choose percent, the table width will dynami-

cally change so that it matches that percent of the screen. It’s usually

a good idea to stick with pixels when first learning how to use tables.

So, we’ll use pixels throughout this session so that the table is al-

ways the same width no matter what the screen width. (At the end of

this session, we’ll consider a classic example of when it makes sense

to use percent.)

We’ll set up our table with three rows and three columns, a width of

800 pixels, and also include a summary to make it accessible to screen

readers for people with visual disabilities. Again, we will also set the

cell padding to 20.
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Set the table to have three rows and three
columns, a width of 800 pixels, cell padding to
20, cell spacing to 0, and a summary such as the
following:

We are not going to worry about the other settings for now. Also, rest

assured it will be easy to reset any of these settings later.

After entering these properties, click OK.

Your screen should resemble the following:

Notice that the Property Inspector at the bottom of the screen con-

tains the settings we just made. A reminder that the Property Inspec-

tor is context sensitive — it shows the properties of whatever is high-
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lighted on the screen.  Later on, if you want to reset any of the table

properties, you will need to select the <table> tag located in the bot-

tom left-hand corner of the document window:

Resizing the Table

Fortunately, resizing this table is as easy as clicking and dragging on

some key parts of the table itself.  For example, notice how the cur-

sor changes into one of two shapes: a two-headed arrow called the

resizing pointer; and a single-arrow pointer. The resizing pointer ap-

pears when the cursor hovers over any of the table cell boundaries,

or the right or bottom edge of the table. If you click and hold the left

mouse button when the resizing pointer appears, you can move that

particular boundary. To resize the table itself, use the resizing pointer

to adjust the bottom or right edges of the table.

The single-arrow pointer will appear when you are just above or to

the left of the table.  This is used to select an entire row or column.

It takes some practice to use the resizing pointer to reshape the table

as you wish. So, please be patient and playful as you explore this.

But, we have a goal in mind.

Using the resizing pointer tool, resize and
reshape the table so that it resembles the
following:

Next, we will add content and color to the various cells, rows or

Resizing Pointer
Tool
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columns. Again, the suggestion is to think screen “zones”.  Here is

what we are trying to create:

Resizing the table this way is somewhat clever because it creates an

attractive colored border between these zones in the shape of a cross.

This cross is mostly decorative, though you can see that we are going

to use part of it to contain a simple navigation bar. (This navigation

bar could just as easily be placed vertically in the vertical axis of the

cross.) Because we set the cell padding to 20, the content in the in-

formation zone is comfortable spaced away from the cell’s border.

Okay, let’s do this for ourselves. Let’s start by adding our name in

the heading and a little blurb about ourselves in the information zone,

and link titles in the navigation zone. (Feel free to copy and paste

text into the information zone from your older pages that we recom-

mended renaming as “index2.htm” and “resume2.htm”.) We’ll add

color soon.

Add content to your table’s three zones.

Center and enlarge the title as you learned in previous sessions.

However, there are a couple of peculiarities related to tables that you

need to be aware of. For example, as you type in the information

zone, you’ll probably notice how the text is vertically placed in the

middle of this cell:

Heading Zone

Information Zone

Navigation Zone

The dotted lines will
disappear when the
page is actually
displayed in a web
browser.
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To have it its initial placement located at the top of the cell, we have

to change the vertical property for this cell. The cell must be active

(i.e. we should be working in it) in order for its properties to show in

the Property Inspector.

Click anywhere inside the cell to show the
properties of that cell in the Property Inspector
window.

Change the vertical setting from “default” to
“top”:

Play with these various cell properties to get the contents of the cell

placed just where you want it.

Adding Color to the Table

It’s time to have some fun with color.  A great thing about a table is

that you can change the color of an entire row or column, or just to a

particular cell. Let’s add color to the row and column that defines the

boundary cross.

Choose the middle row either by clicking in the
first cell of the row and dragging to the last cell
of the row, or by placing the cursor just to the
left of the row, waiting until the cursor changes
into the single-arrow pointer and clicking once.

In the Property Inspector, choose a background
color for this row:
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Actually, what you’ve done is select the background color for this

collection of cells in the row (different background colors can also

be assigned one cell at a time). After you choose the color, notice that

a strange seven character code appears in the small text field, a pound

sign # followed by a collection of six numbers or letters. This is the

hexadecimal code for the color.

We now do the same for the middle column. The goal here is to

match exactly the color we just chose for the row. You can do this in

one of three ways: 1) remember where the color was located on the

pop-up color palette; 2) copy and paste the hexadecimal code from

the row to this column; or 3) use the color picker tool.  We’ll choose

the third choice.  The color picker actually allows you to choose any

color you find on the screen (including from other windows that might

be open that have nothing to do with Dreamweaver, such as a favor-

ite web site with colors you like). The color picker is shown in the

shape of an eye dropper based on the metaphor that we are taking a

sample of that color (similar to using a real eye dropper to take a

sample from an open paint bucket).

Choose the middle column either by clicking in
the first cell of the column and dragging to the
last cell of the column, or by placing the cursor
just to the top of the column, waiting until the
cursor changes into the single-arrow pointer and
clicking once.

In the Property Inspector, choose a background
color for this column by moving the color picker
(eye dropper symbol) to one of the previously
colored cells.

The color you choose
will be added to the
entire row.
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In my case, I’m using a light gray so it will appear clear in this docu-

ment after it is printed. Hopefully, you will use something a bit more

colorful!

A Little More about Color

Unless you are a trained graphic artist or designer, or just gifted when

it comes to graphic design, you might find it a challenge to find col-

ors that work well together.  Fortunately, there are some web sites

you can turn to for help.

One of my favorites is ColorMatch 5k (http://www.colormatch.dk/).

This simple web site lets you choose a base color by sliding three

bars corresponding to the intensity of red, green, or blue.  As you do

so, it automatically generates a six color palette — your base color

and five colors that work well with it based on color theory.  You can

then copy and paste the hexadecimal code of any of the colors into

the appropriate color fields in Dreamweaver:

Another strategy is to find a web site that uses colors you think work

well together. Open that web site in a separate window while work-

ing in Dreamweaver and use Dreamweaver’s color picker tool to

take samples of the colors directly from that web site. Pretty clever,

huh?
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Setting Up a Navigation Bar

Now let’s focus on the navigation zone of our table. If you haven’t

already, create a simple navigation bar by typing key words for links

to various pages in your site, all separated by a vertical bar (by press-

ing shift-\).

Create a simple navigation by typing “Home |
Resume | Philosophy Statement | About Me” in
the navigation zone:

Beginner designers underestimate the need to have a clear and con-

sistent navigational design in their web site.  The last thing we want

is for visitors to our web sites to be annoyed or confused about how

to get from “here to there”.  By setting up a consistent navigation bar

on each and every page, visitors won’t even have to think about how

to move around your site. A simple way to make sure that each page

has the same consistent layout with the navigation bar in exactly the

right place is to set up a page as the model for other pages in the site.

Then, we can use the “Save as...” file command to save multiple

copies of the page, but with different names. (Alternatively, you could

also “copy and paste” entire files directly in the Files panel.) Before

we do this, we should finish our “index.htm” page so that it is de-

signed just the way we want it.

Time Saver! Creating Links for Pages That

Don’t Exist Yet

In a moment, we are going to use the “Save as...” file command to

makes copies of our “index.htm” page. It serves to reason that the

more we can do in “index.htm” now, the less work we will have later

when we edit the duplicated pages. In session 3 you learned how to

link one file to another using the “Point to File” target method (see p.

39 for a review). This approach works great, but it requires that the

file you want to link to already exists and is listed in the Files panel.

So, we have a choice. We could create  all of the files now, then edit

the links in each page, or we can take a shortcut and type in the links

now even though the files don’t exist yet. Typing in the link now

carries one risk — that we will misspell or mistype the link or link

path. But this risk is far outweighed by the amount of time we will

save by typing in all of the links before we save and duplicate the

“index.htm” page. So, type carefully!

What follows assumes you will create the following files besides the

“index.htm” file: resume.htm, philosophy.htm, and aboutme.htm. If

you plan on having less links, more links, or different links, you should

make that decision now. Yes, you can change your mind, but this will

mean that you will need to update the navigation bar in all of your

pages later.
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Since we are going to place all of these pages in the same directory,

all we need to do is enter the file name itself for the link. (If any of

the pages were going to be located in a different directory, we would

have to include the name of the directory as part of the correct path to

the file. If this is confusing to you, a good recommendation is to

create some “play” files within some “play” directories, link to them

from various other pages using the “point to file” method, and study

the link names generated by Dreamweaver that show the correct path

to the files.)

OK, let’s enter the links to all of these pages.

It may seem strange, but we are also going to include the link to the

home page. When we are finished duplicating all the pages, we will

need to remove the link to that page. But, that is easy to do and won’t

take much time.

Highlight the word “Home” in the navigation bar,
then enter “index.htm” in the link field in the
Property Inspector.

Similarly, we do the same for each of the remaining links.

Highlight the word “Resume” in the navigation
bar, then enter “resume.htm” in the link field in
the Property Inspector.

Highlight the words “Philosophy Statement” in
the navigation bar, then enter “philosophy.htm”
in the link field in the Property Inspector.

Highlight the words “About Me” in the navigation
bar, then enter “aboutme.htm” in the link field in
the Property Inspector.

OK, now is the time to make any final revisions to the page before

we duplicate it.

Finish revising the layout for the “index.htm”
page.

For example, if you haven’t already done so, add a document title:
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This page is now a model for our other pages. Let’s go ahead and use

the “Save as...” method for duplicating this page to create the fol-

lowing: a resume page; a page that will contain our philosophy of

technology integration; and a page that will give some information

about ourselves.

Be sure to save the “index.htm” page one last
time so that all changes to this page have been
saved.

Go to the File menu and choose “Save as...”,
renaming the file as “resume.htm” (and be sure
that it is saved inside the portfolio folder).

Let’s do it again to create the “Philosophy Statement” and “About

Me” pages.

Go to the File menu and choose “Save as...”,
renaming the file as “philosophy.htm (and be
sure that it is saved inside the portfolio folder).

Go to the File menu and choose “Save as...”,
renaming the file as “aboutme.htm (and be sure
that it is saved inside the portfolio folder).

You should now see the new “resume.htm”, “philosophy.htm”, and

Alert! Don’t overlook
this step. If you do, the
final changes won’t be
reflected in the
index.htm file.
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“aboutme.htm” files in the Files panel. Since we used the “Save as”

option, notice that the only page that is now open is this new

“aboutme.htm” page. But, no worries, the “index.htm”, “resume.htm”,

and “philosophy.htm” files should be safe and sound in our portfolio

folder. We’ll open these three other pages in a moment. For now,

let’s make some quick modifications to the “aboutme.htm” page.

One of the first things is to decide whether or not to remove the link

that goes to the page itself. For example, if visitors reading our home

page click on the link “Home”, all this will do is refresh the current

page since they are already at the home page. However, leaving this

link does no harm. So, it is a matter of deciding which is the better

design. If you remove the link, you should still leave the text and I

recommend that you embellish this text in some way to make it stand

out in order to give visitors a visual clue that “you are here”.

Frankly, for simplicity, I recommend just leaving the links alone.

But, in case you want to remove the link on each page that links to

itself, let’s consider how best to do this.

Highlighting the words “About Me” and removing “aboutme.htm”

from the link field in the Property Inspector is one way to do this.

But I think the preferred way is to remove the <a> tag from these

words.

If you choose to remove the link on the page that
links to itself, click anywhere inside the words
“About Me”, then right-click on the <a> tag and
choose to “Remove Tag”.

Again, it’s a good idea to embellish the words “About Me” in some

way, such as with boldface, to make the words stand out a little bit in

order to let a visitor to our web site know that this is the page they are

currently viewing. If you do this, just be sure that all of your pages

use the same embellishment.

The next step is to begin to modify the the rest of the page appropri-

ately, especially the page’s content. Obviously, this is something that

could take weeks to finish. But let’s just make some quick modifica-

tions for now.

Modify the page slightly with some personal
information about yourself.
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So, you might just want to change the page a little bit at this point to

reflect its new role. Also, remember to update the document title so

that it resembles the following:

Similarly, open and modify the other pages: “index.htm”,

“resume.htm” and “philosophy.htm”.

Open and modify the “index.htm”, “resume.htm”
and “philosophy.htm” pages.

Remember, if you choose to modify each page to remove the link to

the page itself, be sure to leave the text of the page name in the navi-

gation bar — all you want to do is remove the hyperlink to itself.

Be sure to either save as you go, or choose “Save All” from the file

menu.

Choose to “Save All” from the file menu to save
the changes in all of your open pages.

You now have a much more attractive web site with a consistent and

easy-to-understand navigational strategy!

Some Final Notes

As you get comfortable using tables, you will discover all sorts of

clever and creative ways to use them to enhance your web site.  For

example, it is perfectly acceptable to place a table within a table. For

example, notice how I placed a small photo of myself at the intersec-

tion of the cross:

Be careful to not tell
too much about
yourself. Remember,
everything in this
web site is a public
document. Of
course, you should
never include
sensitive
information, such as
social security
numbers, street
addresses or home
telephone numbers.
But, you should also
think twice about
posting photos of
yourself or family
members.

Adding something
distinctive at the
intersection of the cross
that is also different on
each page is a great
way to give visitors a
visual clue that they are
moving through your
site. A simple thing to
add to each page at
this attention-gaining
location is simply the
name of the page itself.
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But, because I had originally set the cell padding to 20, I was unable

to get my photo (saved as a transparent GIF, 50X50 pixels in size) to

fill this cell completely. So, I reset the cell padding for the entire

table to 0, but this caused the text in the information zone to hug the

left cell border. So, I inserted a 1X1 table in the information zone and

set the cell padding of it to 20. Then I copied and pasted the informa-

tion zone text into that table. Of course, it can get confusing to keep

track of tables when they nested within each other. Again, the best

strategy is to pay attention to the tags listed in the bottom left-hand

corner of the document window — when you click in a cell within a

table placed in another table you will see the <table> tag listed twice.

Each refers to one and only one table. By the way, it’s a good idea to

set the width of the nested table to 100%, instead of pixels.  That

way, the table will automatically adjust itself to the size of the “outer”

table.

Let me also discuss a little more about the strategy of using “Save

as...” to quickly create multiple pages based on a model page. Al-

though this is a simple and clever strategy, there are drawbacks.  If

you change your mind later on about the layout, you will need to

manually and tediously update each of the web site’s pages. Although

it is outside the scope of this guide, you should know that

Dreamweaver has the ability to create a special resource it calls tem-

plates. A template is a special file that holds a page layout that can be

used by multiple pages on your site. If you change anything in the

template file, all of the pages that are based on it will update auto-

matically. The advantage of a template becomes apparent in a large

site with dozens or hundreds of pages — you make one change and it

is reflected automatically in all of the related pages. So, if you are

going to create a large site based on just one or two basic layouts,

you should explore the use of the Dreamweaver templates.

Finally, you should also know that Dreamweaver has a collection of

sample pages with interesting layouts that you are free to use for

your web site. You can explore these by clicking on the “page de-

sign” links on the Dreamweaver start-up page:

The design of this session was inspired by the teaching of Greg

Clinton.
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Appendix:
Getting Your Web Site on the

Internet

If you completed two or more sessions in this guide, you are prob-

ably anxious to actually get your HTML documents and related files

(such as images) on the Internet so that you, colleagues, prospective

employers, family, and others can access them.  Your web site is not

really on the web until all the files have been correctly transferred to

a web server.  This  step can only be done if you have direct access to

the web server onto which your web pages will be stored.

It is assumed that you have at least completed Session 1 of this guide.

Recall that in Session 1 you defined a new web site for your site’s

local root folder.  This Appendix will guide you through the rest of

the process of defining a site, specifically that dealing with how to

define the “remote” connection to a web server.  When completed,

you will easily be able to upload and maintain all of our web work on

the web server.

Let’s take a closer look at some of the fundamentals of accessing

documents on the web.  For example, a web address (i.e. URL) is

just the path name to the HTML file starting with the name of the

server.  For example, the name of the web server in the Department

of Instructional Technology at UGA is “it.coe.uga.edu”.  The HTML

file is often buried deep within a series of folders (i.e. directories)

indicated by a forward slash (/) in the web address.  For example,

consider the following web address:

The HTML file (“dreamweavermx.htm”) is located in a folder named

“workshops,” which is located in an account named “lrieber” on the

web server named “it.coe.uga.edu”. The tilde symbol (~) right be-

fore the account name serves the same purpose as an apostrophe in

the word “can’t” — it signifies that some part is missing.  Schools

that provide web accounts to its students frequently use account names

such as these.  Fortunately, you do not need to know anything more

about the use of the tilde, if your web address needs one, other than

to make sure that it is part of the web address.  If you are instead

paying for a web hosting service through one of the multitude of web

hosting companies, the account name is usually omitted.

All of your web work will need to be placed in a special folder hid-

den from public view.  Typical names for this folder include

“public_html”, “www”, or “wwwroot”.  If the name of this folder is

not readily apparent in the documentation provided to you by your

web hosting administrators, then you’ll need to check with them for

this information before you will be able to set up your web site with

Dreamweaver.

web server
(i.e. computer)

name

account
name

folder
name

HTML
document

it.coe.uga.edu/~lrieber/workshops/dreamweavermx.htm
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There can be several ways to upload, or put, your files onto a web

server. If you have direct access to the web server, you could just put

in your floppy or zip disk and copy the files directly to it.  However,

it is much more likely that you have no idea where the web server is

physically located.  Therefore, the most common way to upload files

to a web server is through FTP, which stands for File Transfer Proto-

col. FTP defines a standard for transferring files between computers

at a distance.  The powerful thing about FTP is that the procedures

even work if the computers on either end are Windows, Macintosh,

Unix, etc. As long as each has the appropriate FTP capability and

there is a way to connect the two computers (such as via a phone

line), it will all work.

Site management is one of the most powerful features of

Dreamweaver.  Built-in to Dreamweaver is a large assortment of FTP

capabilities.  Without these capabilities, you would have to use a

separate FTP application. WS_FTP is the most common Windows

FTP application and FETCH is the most common Macintosh FTP

application. If you are already familiar with either of these tools, you

can continue to use them. However, once you experience the site

management features of Dreamweaver, you will probably wonder

how you ever got along with them.

If you are completely new to site management and have never up-

loaded or downloaded anything via FTP software, the good news is

that you can start immediately with Dreamweaver and let it handle

virtually all of your FTP needs.  It is even possible that you may

never need to use any other FTP application. However, it is still to

your advantage to become familiar with an FTP application and to

have it on hand for occasional use.  There are also many good guides

already available on how to use them. For example, there is a nice

overview of both tools at the following web site:

http://www.arches.uga.edu/upload.html

Editing Web Sites Created with

Dreamweaver

Again, it is assumed that you have at least completed Session 1 of

this guide.  We will now turn out attenting to editing the site you

created there called “My Portfolio Web site” to define the “remote”

connection to a web server.

Launch Dreamweaver.

As always, if you are working on the same computer as you did the

previous sessions and you are the last person to have worked on

Dreamweaver, your portfolio web site will come up automatically.

If this is not the case, you will again need to define a local site, as

described in session 1.

FTP — File Transfer
Protocol
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You will probably have a blank “untitled document” opened for you.

That’s fine. We don’t need to open any files associated with our web

site to continue.

Click on the mini-menubar symbol in the top right
corner of the Files panel, then select “Site −−−−−
Manage Sites...” from the pop-upmenu:

This opens a small dialog box listing all of the available sites (be-

sides the site you set up earlier, you may also see some samples sites

that come along with Dreamweaver):

Choose “My Portfolio Web Site” from the list (or
whatever you called your site when you first
defined it), then select “Edit...”.

You can also get
there by choosing
“Site” from
Dreamweaver’s file
menu.
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This opens the site definition dialog box and it is likely that the site

definition wizard opens, as indicated by the “Basic” tab in the upper

left hand corner.  However, we are going to use the “Advanced” sec-

tion instead. Don’t worry, it’s not really that advanced!  Instead of

taking us through all of the parts page by page, we can quickly enter

all of the information we need for our remote site on one page.

Click once on the tab marked “Advanced”.

Choose “Remote Info” from the list of categories
on the left side.

Your screen should now resemble the following:

We need to tell Dreamweaver how we intend to access our site. The

most typical way is via FTP (file transfer protocol)

Click on the triangle graphic beside “Access:”
to show the pop-up menu.

Select “FTP” from the list.
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After you choose FTP, Dreamweaver displays the required informa-

tion fields:

Entering the correct information is critical here. There is no room for

error.  You might even have to use some “trial and error” to identify

the correct information for all the fields.

Here is the window completed properly for my ARCHES web server

account at the University of Georgia:

Let’s explore each of the entries, one by one.
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The FTP Host is the name of the web server and is almost always

the same name as the top most level of the HTTP address.  Interest-

ingly, in my case, the name is not exactly the same — the “www.” is

missing at the beginning and it won’t work any other way. If you

can’t discover the correct name on your own, you will need to check

with your web server administrator for this information.

The Host Directory is the name of the directory on your web server

into which all of your web files must be located. Many servers use

“public_html”. Other typical names are “www” and “wwwroot”. You

might even need to just leave this field blank.  Again, if these don’t

work, check with your web server administrator.

Your Login and Password were given to you when you set up your

server account.  For many students, these are the same Login and

Password that they use to check their email on this account.

Leave the other options on this page unchecked.

That’s it. Let’s test the connection to our remote server.

Click “Test”.

If successful, you will see the following message:

If unsuccessful, you will see one of several possible messages. For

example, this message indicates that you have entered the wrong

FTP host:

Cross your fingers
while you do this to
hope that you entered
everything correctly!
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This one indicates that either your log-in username or password is

incorrect:

Finally, this one indicates that you have entered the wrong host di-

rectory:

If your connection did not work, you will need to edit your site to

revise the connection information.

It can take a few tries to get it all right.  The beauty of Dreamweaver

is that once you set up a site properly, it will store this information

permanently in your computer’s system files. So, if you are using

your own computer for all of your Dreamweaver work, you only

have to go through this site definition process once.  If  you are work-

ing on more than one computer, you will have to define the site for

each computer.

Click “OK”.

This sends you back to the list of sites.

Click “Done”.

Even though things don’t look much different than they were before,

there is a world of difference at this point — you are now in the

position to upload your files directly to the web server!

Uploading could not be easier.  It is just a matter of selecting the files

or folders, then clicking the blue up arrow, officially called the “put

files” button. But before we do so, let’s take a look at our remote

server.

You can choose to view the remote server by choosing “remote” view

from the site panel window. But, I recommend we go ahead and look

at both the local and remote files at the same time by clicking on the

“expand/collapse” button on the far right of the site panel (it looks

like a small notepad with a blue arrow).

This error message,
at least, gives a hint
as to the problem.
Notice that I
mistakenly typed an
“n” instead of an “m”
in “public_html”.
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Click once on the “Expand/Collapse” button in
the site panel.

If you get a pop-up message saying that “the site map cannot be

built...”, just ignore it by pressing “Cancel”.

Your screen should resemble the following:

This is a split window. On the right hand side are our local files and

the remote files will be on the left.  The left side is blank because we

do not have a live connection yet with our web server. Let’s initiate

the connection.

Click on the “Connect to remote host” symbol.

This symbol looks like two disconnected plugs:

If you correctly entered all of the necessary information, Dreamweaver

will correctly connect to your remote server and list all of the files

associated with the host directory on the remove server:

Click hereGet the metaphor?

Click here
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One thing that is important to notice is that the remote host directory

(i.e. “public_html” in my case) corresponds with the folder “My lo-

cal web files” on your computer (though you will need to click once

on it to reveal the complete path):

This is perfect.  All of your remote files for all of your web site,

present and future, will reside in your remote host directory just as

all of your local files are stored in the folder “My local web files”

that we created at the beginning of this guide.

Uploading Your Web Site to a Remote Web

Server

To upload any or all of your site to the remote server, you merely

click on the file/s or folder/s you want to upload, then click on the

“Put File(s)” symbol (the blue up arrow). We’ll go ahead and upload

the entire site at this point.

Select the “portfolio” directory in your Local
Folder (right) side of the site window, then click
on the “Put File(s)” symbol.

Dreamweaver asks you if you want to include “dependent files”.

Dependent files are things like images and sounds that are linked to

this page. This is a handy option if you made significant modifica-

tions to the page, such as adding more graphics, Dreamweaver will

automatically upload all the graphics, sounds, etc. that are linked to

this page to the server for you. But, if you know you only changed

the text, which is very typical, you can click no.
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Click “No”.

Dreamweaver then uploads (puts) all of the selected files to your

server.  You will see a dialog box like the following as the files are

transferred:

When finished, Dreamweaver automatically refreshes the Remote

Site (left) side of the site window:

You are now on the web! Let’s test it with Internet Explorer or

Netscape to be sure everything is really on the Internet.

Testing Your Site

Launch a web browser (e.g. Internet Explorer)
and enter the URL of your web site.

Here again is the URL for my portfolio on the ARCHES server at the

University of Georgia:

http://www.arches.uga.edu/~lrieber/portfolio

(Obviously, you should type the URL of your web site to test it.)

Notice that I did not enter the file name “index.htm” at the end.  It

was not necessary to do so because this is the special default name

for a web file on this particular server. If I had used any other name

for this file, I would have had to type a “/” followed by the file name.

Obviously, only one file per directory can have this special name, so

it is reserved for the home page for that directory.
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If you uploaded your web site correctly and entered the URL  with-

out a single error, it will appear in the browser window:

You can update your web site as often as you like using Dreamweaver.

For example, after previewing my home page, I’ve decided I don’t

like the textured background after all. So, I double-clicked on the file

“index.htm” in my local view and deleted the background image. It

certainly doesn’t make sense to upload the entire web site again just

to reflect this one change.  All I had to do was click on the “put files”

button (blue up arrow) that appears at the top of the file widow, then

choose “Put” from the list:

I forgot to save the file first, but fortunately Dreamweaver prompts

me to do so:
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My web site has been immediately been updated.  To check, I go

back to Internet Explorer.  If the window is still open, all I need to do

is click the Refresh button:

Other Useful Site Management Features

There are a variety of other useful features you can access from this

window.

You can refresh your local folder and remote site by clicking on the

Refresh symbol (blue circle with arrow).

Of course, you can download files from the server to your disk with

the “Get File(s)” symbol (downward pointing green arrow). Of course,

you have to be very careful when doing this as this will overwrite

your local file.

Finally, Dreamweaver also one clever site management tool, called

“Synchronize”, to allow you to quickly update all files that have re-

cently changed. The Synchronize feature can be found in the Site

menubar:

Given these powerful site management tools, you should be able to

quickly build and maintain the most sophisticated of web sites.


